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Microsoft® Office Excel® 2007 is a spreadsheet program that can be used to organize and analyze data, 
perform complex calculations, and create a wide variety of graphical displays. We assume readers of this 
primer are familiar with basic Excel operations such as selecting cells, entering formulas, copying, and so 
on. But, we do not assume readers are familiar with Excel 2007. 
 
The purpose of this primer is twofold. First, we provide an overview of Excel 2007 and discuss the basic 
operations needed to work with Excel 2007 workbooks and worksheets. Second we provide an introduction 
to building mathematical models using Excel, including a discussion of how to find and use a particular 
Excel function. A variety of tools are available when using Excel 2007 to develop mathematical models. 
These include Excel’s Goal Seek tool, Excel’s Solver, and commercially available add-ins such as 
Premium Solver for Education, and TreePlan. We discuss the use of these additional tools in selected 
chapter appendixes in An Introduction to Management Science. 
 
 
OVERVIEW OF MICROSOFT EXCEL 2007 
 
When using Excel for modeling, the data and the model are displayed in workbooks, each of which 
contains a series of worksheets. Figure 1 shows the layout of a blank workbook created each time Excel is 
opened. The workbook is named Book1, and consists of three worksheets named Sheet1, Sheet2, and 
Sheet3. Excel highlights the worksheet currently displayed (Sheet1) by setting the name on the worksheet 
tab in bold. To select a different worksheet simply click on the corresponding tab. Note that cell A1 is 
initially selected. 
 
The wide bar located across the top of the workbook is referred to as the Ribbon. Tabs, located at the top of 
the Ribbon, provide quick access to groups of related commands. There are eight tabs: Home, Insert, Page 
Layout, Formulas, Data, Review, View, and Add- Ins. Each tab contains several groups of related 
commands. Note that the Home tab is selected when Excel is opened. Figure 2 displays a portion of the 
Home tab. Under the Home tab there are seven groups of related commands: Clipboard, Font, Alignment, 
Number, Styles, Cells, and Editing. Commands are arranged within each group. For example, to change 
selected text to boldface, click the Home tab and click the Bold button in the Font group. 
 
Figure 3 illustrates the location of the Office Button, the Quick Access Toolbar, and the Formula Bar. 
When you click the Office Button, Excel provides a list of workbook options such as opening, saving, and 
printing (worksheets). The Quick Access Toolbar allows you to quickly access these workbook options. 
For instance, the Quick Access Toolbar shown in Figure 3 includes an Open button that can be used to 
open files without having to first click the Office Button. To add or remove features on the Quick Access 
Toolbar click the Customize Quick Access Toolbar button on the Quick Access Toolbar. 



 
 
 
The Formula Bar contains a Name box, the Insert Function button , and a Formula box. In Figure 3, 
“A1” appears in the Name box because cell A1 is selected. You can select any other cell in the worksheet 
by using the mouse to move the cursor to another cell and clicking or by typing the new cell location in the 
name box and pressing the enter key. The Formula box is used to display the formula in the currently 
selected cell. For instance, if you had entered =A1+A2 into cell A3, whenever you select cell A3 the 
formula =A1+A2 will be shown in the Formula box. This feature makes it very easy to see and edit a 
formula in a particular cell. The Insert Function button allows you to quickly access all of the functions 
available in Excel. Later we show how to find and use a particular function. 



 



 
 
BASIC WORKBOOK OPERATIONS 
Figure 4 illustrates the worksheet options that can be performed after right clicking on a worksheet tab. For 
instance, to change the name of the current worksheet from “Sheet1” to “NowlinModel,” right click the 
worksheet tab named “Sheet1” and select the Rename option. The current worksheet name (Sheet1) will be 
highlighted. Then, simply type the new name (NowlinModel) and press the Enter key to rename the 
worksheet. 
 
 Suppose that you wanted to create a copy of “Sheet 1.” After right clicking the tab named 
“Sheet1,” select the Move or Copy option. When the Move or Copy dialog box appears, select Create a 
Copy and click OK. The name of the copied worksheet will appear as “Sheet1 (2).” You can then rename 
it, if desired. 
 
To add a worksheet to the workbook, right click any worksheet tab and select the Insert option; when the 
Insert dialog box appears, select Worksheet and click OK. An additional blank worksheet titled “Sheet 4” 
will appear in the workbook. You can also insert a new worksheet by clicking the Insert Worksheet tab 
button  that appears to the right of the last worksheet tab displayed. Worksheets can be deleted by right 
clicking the worksheet tab and choosing Delete. After clicking Delete, a window will appear warning you 
that any data appearing in the worksheet will be lost. Click Delete to confirm that you do want to delete the 
worksheet. Worksheets can also be moved to other workbooks or a different position in the current 
workbook by using the Move or Copy option.  
 
 
 
Creating, Saving, and Opening Files 
As an illustration of manually entering, saving, and opening a file we will use the Nowlin Plastics 
production example from Chapter 1 of An Introduction to Management Science. The objective is to 
compute the breakeven point for a product that has a fixed cost of €3000, a variable cost per unit of €2, and 
a selling price per unit of €5. We begin by creating a worksheet containing the problem data. 
 
 If you have just opened Excel, a blank workbook containing three worksheets will be displayed. 
The Nowlin data can now be entered manually by simply typing the fixed cost of €3000, the variable cost 
of €2, and the selling price of €5 into one of the worksheets.  



If Excel is currently running and no blank workbook is displayed, you can create a new blank workbook 
using the following steps: 
 
Step 1:  Click the Office button 
Step 2:  Click New in the list of options 
Step 3:  When the New Workbook dialog box appears: 
 Select Blank and recent under Templates 
 Double click Blank Workbook 
 
 
A new workbook containing three worksheets labelled Sheet1, Sheet2, and Sheet3 will appear. 
 
 We will place the data for the Nowlin example in the top portion of Sheet1 of the new workbook. 
First, we enter the label “Nowlin Plastics” into cell A1. To identify each of the three data values we enter 
the label “Fixed Cost” into cell A3, the label “Variable Cost Per Unit” into cell A5, and the label “Selling 
Price Per Unit” into cell A7. Next, we enter the actual cost and price data into the corresponding cells in 
column B: the value of €3000 in cell B3; the value of €2 in cell B5; and the value of €5 into cell B7. 
Finally, we will change the name of the worksheet from “Sheet1” to “NowlinModel” using the procedure 
described previously. Figure 5 shows a portion of the worksheet we have just developed. 
 
Before we begin the development of the model portion of the worksheet, we recommend that you first save 
the current file; this will prevent you from having to re-enter the data in case something happens that causes 
Excel to close. To save the workbook using the filename Nowlin we perform the following steps: 
 
Step 1:  Click the Office button 
Step 2:  Click Save in the list of option 
 
 

 



Step 3:  When the Save As dialog box appears: 
 In the Save in box select the location where you want to save the file 
 Type the filename Nowlin in the File name box 
 Click Save 
 
Excel’s Save command is designed to save the file as an Excel 2007 workbook. As you work with and 
build models in Excel you should follow the practice of periodically saving the file so you will not lose any 
work. Simply follow the procedure described above using the Save command. 
 
Sometimes you may want to create a copy of an existing file. For instance, suppose you change one or 
more of the data values and would like to save the modified file using the filename “NowlinMod.” The 
following steps show how to save the modified workbook using filename NowlinMod. 
 
Step 1:  Click the Office button 
Step 2:  Position the mouse pointer over Save As 
Step 3:  Click Excel Workbook from the list of options 
Step 4:  When the Save As dialog box appears: 
 In the Save in box select the location where you want to save the file 
 Type the filename NowlinMod in the File name box 
 Click Save 
 
Once the NowlinMod workbook has been saved, you can continue to work with the file to perform 
whatever type of analysis is appropriate. When you are finished working with the file simply click the close 
window button located at the top right-hand corner of the Ribbon. You can easily access a saved file at 
another point in time. For example, the following steps show how to open the previously saved Nowlin 
workbook. 
 
Step 1: Click the Office button 
Step 2: Click Open in the list of options 
Step 3: When the Open dialog box appears: 
In the Look in box select the location where you previously saved the file 
Type the filename Nowlin in the File name box 
Click Open 
 
The procedures we showed for saving or opening a workbook begin by clicking on the Office Button to 
access the Save and Open commands. Once you have used Excel for awhile you will probably find it more 
convenient to add these commands to the Quick Access Toolbar. 
 
 
MODEL DEVELOPMENT 
Assume that the Nowlin workbook is open again and that we would like to develop a model that can be 
used to compute the profit or loss associated with a given production volume. We will use the bottom 
portion of the worksheet shown in Figure 5 to develop the model. First, we enter the label “Models” into 
cell A10 to provide a visual reminder that the bottom portion of this worksheet will contain the model. 
Next, we enter the labels “Production Volume” into cell A12, “Total Cost” into cell A14, “Total Revenue” 
into cell A16, and “Total Profit (Loss)” into cell A18. Cell B12 is used to contain a value for the production 
volume. We will now enter formulas into cells B14, B16, and B18 that use the production volume in cell 
B12 to compute the values for total cost, total revenue, and total profit or loss. 
 
Total cost is the sum of the fixed cost (cell B3) and the total variable cost. The total variable cost–the 
product of the variable cost per unit (cell B5) and production volume (cell B12)–is given by B5*B12. Thus, 
to compute the value of total cost we enter the formula =B3+B5*B12 into cell B14. Next, total revenue is 
the product of the selling price per unit 



 
 
(cell B7) and the number of units produced (cell B12), which we enter in cell B16 as the formula =B7*B12. 
Finally, the total profit or loss is the difference between the total revenue (cell B16) and the total cost (cell 
B14). Thus, in cell B18 we enter the formula =B16-B14. Figure 6 shows a portion of the formula 
worksheet we have just developed. We can now compute the total profit or loss for a particular production 
volume by entering a value for the production volume into cell B12. Figure 7 shows the results after 
entering a value of 800 into cell B12. We see that a production volume of 800 units results in a total cost of 
€4600, a total revenue of €4000, and a loss of €600. 
 
USING EXCEL FUNCTIONS 
 
Excel 2007 provides a wealth of functions for developing mathematical models. If we know which function 
is needed, and how to use it, we can simply enter the function into the appropriate worksheet cell. 
However, if we are not sure which functions are available to accomplish a task or are not sure how to use a 
particular function, Excel can provide assistance. 
 
Finding the Right Excel Function 
To identify the functions available in Excel, click the Formulas tab on the Ribbon and then click the Insert 
Function button in the Function Library group. Alternatively click the  button on the formula bar. 
Either approach provides the Insert Function dialog box shown in Figure 8. 
 
The Search for a function box at the top of the Insert Function dialog box enables us to type a brief 
description for what we want to do. After doing so and clicking Go, Excel will search for and display, in 
the Select a function box, the functions that may accomplish our task. In many situations, however, we 
may want to browse through an entire category of functions to see what is available. For this task, the Or 
select a category box is helpful. 



 



It contains a drop-down list of several categories of functions provided by Excel. Figure 8 shows that we 
selected the Math & Trig category. As a result, Excel’s Math & Trig functions appear in alphabetical order 
in the Select a function box. We see the ABS function listed first, followed by the ACOS function, and so 
on. 
The ABS function is highlighted in Figure 8, indicating it is the function currently selected. The proper 
syntax for the function and a brief description of the function appear below the Select a function box. We 
can scroll through the list in the Select a function box to display the syntax and a brief description for each 
of the Math & Trig functions that are available. For instance, scrolling down farther, we select the 
SUMPRODUCT function as shown in Figure 9. The SUMPRODUCT function is used in many of the 
Solver examples in the textbook. Note that SUMPRODUCT is now highlighted, and that immediately 
below the Select a function box we see SUMPRODUCT(array1,array2,array3, . . .), which indicates that 
the SUMPRODUCT function contains the array arguments array1, array2, array3, . . . . In addition, we see 
that the description of the SUMPRODUCT function is “Returns of the sum of the products of 
corresponding ranges or arrays.” 
 
If the function selected (highlighted) is the one we want to use, we click OK; the Function Arguments 
dialog box then appears. The Function Arguments dialog box for the SUMPRODUCT function is shown in 
Figure 10. This dialog box assists in creating the appropriate arguments for the function selected. When 
finished entering the arguments we click OK; Excel then inserts the function into a worksheet cell. 
 

 



 
 
Inserting a Function into a Worksheet Cell 
We will now show how to use the Insert Function and Function Arguments dialog boxes to select a 
function, develop its arguments, and insert the function into a worksheet cell.  
 
 Figure 11 displays an Excel worksheet for the Foster Generators Problem that appears in Chapter 7
 of An Introduction to Management Science. This problem involves the transportation of a product 
from three plants (Czech Rep, Brazil, and China) to four distribution centers (Boston, Dubai, Singapore, 
and London). The costs for each unit shipped from each plant to each distribution center are shown in 
cells B5:E7, and the values in cells B17:E19 are the number of units shipped from each plant to each 
distribution center. Cell B13 will contain the total transportation cost corresponding to the transportation 
cost values in cells B5:E7 and the values of the number of units shipped in cells B17:E19. The following 
steps show how to use the SUMPRODUCT function to compute the total transportation cost for Foster 
Generators. Step 1: Select cell C13 
 

Step 2: Click on the formula bar 
Step 3: When the Insert Function dialog box appears 
Select Math&Trig in the Or select a category box 
Select SUMPRODUCT in the Select a function box 
Click OK 
Step 4: When the Function Arguments box appear (see Figure 12) 
Enter B5:E7 in the Array1 box 
Enter B17:E19 in the Array2 box 
Click OK 



 
 

 
 



 
 

 
 
 
The worksheet then appears as shown in Figure 13. The value of the total transportation cost in cell C13 is 
39500 or €39,500. 
We illustrated the use of Excel’s capability to provide assistance in using the SUMPRODUCT function. 
The procedure is similar for all Excel functions. This capability is especially helpful if you do not know 
what function to use or forget the proper name and/or syntax for a function. 
 
ADDITIONAL TOOLS FOR MODELING 
In An Introduction to Management Science  we illustrate a variety of Excel tools that are helpful in 
developing mathematical models. For example, in Appendix 1.1 we show how Excel’s Goal Seek tool is 
used to compute the breakeven point for the Nowlin Plastics example. An add-in package titled Premium 
Solver for Education, included on the Student CD, extends the range of problem type and size that can be 
handled using Excel Solver. 
 


